
 

1 

 
             

 
 
 
 
 
 
 
 
 
 
 
 
 

                 

 

 
 

OSP Configuration Software 
 (Suitable for TWINFLEX®pro control panels from V1.00) 

 
 
 
 
 
 
 

Software Operating Instructions 
(TO BE RETAINED BY THE COMMISSIONING ENGINEER) 

 
 
 
 

 
 
 
 
 
 
 

  
 
 
 
 

26-1129 Issue 1 



TWINFLEX
®
pro OSP Software Operating Instructions 

  

 

 2

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Fike’s policy is one of continual improvement and the right to change a specification at any time without notice is reserved. Whilst every care 
has been taken to ensure that the contents of this document are correct at time of publication, Fike shall be under no liability whatsoever in 
respect of such contents. 
 
Due to the complexity and inherent importance of a life risk type system, training on this equipment is essential and commissioning should only 
be carried out by competent persons. 
 
Fike cannot guarantee the operation of any equipment unless all documented instructions are complied with, without variation.  
 
E&OE. 

 
TWINFLEX, Mulitpoint, Fike and Fike Corporation are registered trademarks of Fike Corporation and its subsidiaries. All other trademarks, 
trade names or company names referenced herein are the property of their respective owners. 
 
Fike equipment is protected by one or more of the following patent numbers: GB2426367, GB2370670, EP1158472, PT1035528T, 
GB2346758, EP0917121, GB2329056, EP0980056, GB2325018, GB2305284, EP1174835, EP0856828, GB2327752, GB2313690 
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Introduction 
 

TWINFLEX
®
pro OSP is the name given to the high level software package written to enable the individual 

configuration of the TWINFLEX
®
pro fire alarm systems. This Windows based program allows the system to 

be set up for each application. Note that whichever panel is used, there is no difference in the mode of 
operation of the program. 
 
Much thought has taken place to implement operations in as simple a way as possible whilst not losing 
flexibility through over-simplification.  
 
Tools are also included to enable you to create reports and specifications from your programming, including 
both configuration and event log reports. 

 
 

Getting Started 
 
System Requirements 
 

The TWINFLEX
®
pro OSP configuration software is available on the Fike Software CD. In order to run the 

program you will require the following: 
 

• A desktop or laptop PC running the Windows XP or Windows 7 operating system (32-bit 
versions) with at least 1GB RAM.  

o The PC must have a CD drive in order to install your software. 
o The PC must have a USB port for connection to the panel. 

• A USB interface lead for connection of the PC to the control panel. 

 
 

Physical Connections 
 
The USB Interface lead connects between the USB port on the control panel and any USB port on the PC. 

 

 

Software Installation 
 

Important: Install software and driver before connecting to panel. 
 
In order to commence installation, insert the OSP CD-ROM in your CD-ROM drive.  
 
NOTE: If the CD does not autorun on your chosen PC, open up the CD in Windows Explorer. The CD may 
contain a number of different directories. Locate the file titled ‘TWINFLEXpro OSP Setup.exe’ and run it. 
 
Follow the instructions while the software loads onto your hard disk drive. The software will be installed in 
the following location: 
  

C:\ Program Files \ FST \ TWINFLEXpro OSP \ 
 

If required, a shortcut from the file titled ‘TWINFLEXpro_OSP.exe’ may then be copied onto the desktop for 
ease of access, and labelled with the actual software version number (eg. V1.10) to prevent confusion with 
possible future releases.   
  
Note that USB drivers for the TWINFLEX

®
pro will have to be installed before the panel can be 

connected to the USB port. These are normally installed as part of the OSP software installation. 
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TWINFLEX®pro OSP Layout 
 

Main Screen 
 

 
 
 

The ‘Status & Menu’ screen is the front page, index and guide for programming using TWINFLEX
®
pro 

OSP. Functions are controlled via the various on-screen buttons (arranged vertically to the left of the 
screen) and menus (arranged horizontally at the top of the screen). 
 
When features in the OSP program are selected by pressing buttons, Cancel and OK buttons will appear at 
the bottom of the screen. OK is pressed to accept any changes to the data that you make. Cancel is 
pressed to leave the feature without saving any data changes. 
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‘File’ Menu 
 

 
 
The ‘File’ menu contains the following options: 

 
New  
 
This feature will create a ‘New’ configuration file with extension *.TF4.  
 
This file type may be classed as ‘unlocked’, allowing modifications to be made to the configuration. 
 

Note that a site may consist of more than one stand alone panel. TWINFLEX
®

pro panels are not 
networkable). 
 
This function is also repeated in the form of an on-screen button in the toolbar immediately below the file 
menu. 
 

    i.e.  
 
Open 
 
This feature will open an existing, or ‘Old’ configuration file so that it can viewed and modified if required. 
This function is also repeated in the form of an on-screen button in the toolbar immediately below the file 
menu. 
  

    i.e.   
 
Note that if a file is modified, it should be downloaded to the panel to make sure the panel configuration is 
up to date. The file is not locked to a specific panel so the same configuration can be loaded to multiple 
panels if required (provided it is suitable). 
 
Save As 
 
This feature will save configuration file to the file name and address of your choice.  
 

  
Exit 
 

Exit the TWINFLEX
®

pro OSP program. 
 

 

New Files 
 

You will first be prompted with a “Save As” screen for a name for the site. Site data files are saved with type 
.TF4. 
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Tools Menu 
 

 
 

Comm Port Settings 
 

 

 
 
 
The only thing that may need to be changed on this menu is the Communications Port which will depend on 
the PC that is being used. This will be the port set by the USB driver. 
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View Menu 
 

 
 

 
 

Panel Details 
 

Clicking on Panel Details or the Panel Details button brings up the following screen. 
 
This function is also repeated in the form of an on-screen button in the Left hand side toolbar. 
 

 
 
 

 
 

Note that there are eight tabs on this screen, each of which is described below. 
 
Panel Summary Tab 
 
On this tab you can use the four buttons at the bottom of the screen to add, delete, copy and import panels 
from the configuration data as follows. 
 

Add 
 

The Add button on the upload screen allows you to add a new panel to the current configuration on 
the PC. This feature is also available on the “Upload Data” screen available from the “Upload from 
Control Panel” button.  
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Delete 
 

The Delete button allows you to delete a panel from the current configuration on the PC. This 
feature is also available on the “Upload Data” screen available from the “Upload from Control 
Panel” button. 

 
 
Copy 

 
The Copy button on the upload screen allows you to copy the details from an existing panel to a 
new panel number on the PC. This feature is also available on the “Upload Data” screen available 
from the “Upload from Control Panel” button. 
 

 
 

In the above example, we have selected Panel 001 from that site and the data from that panel will 
be copied into Panel 002 in our configuration.  The data may only be copied to a panel number that 
does not already exist in the configuration. If you want to copy the data to an existing panel, the 
existing panel should first be deleted using the Delete button. 

 
 Import 

 
The Import button allows you to browse for a DIFFERENT site and copy the details of a panel on 
that site to a panel number in the current configuration. This feature is also available on the “Upload 
Data” screen available from the “Upload from Control Panel” button. 
 

 

 
 

 
In the above example, we have picked a different site named New1.TF4. We have selected Panel 
001 from that site and the data from that panel will be copied into Panel 002 in our configuration.  
The data may only be imported to a panel number that does not already exist in the configuration. If 
you want to import the data to an existing panel, the existing panel should first be deleted using the 
Delete button. 
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Panel Details Tab 
 
The Panel Details tab is shown below. 
 

 
 

In the top section you can select the panel and the details of the selected panel will appear in the bottom 
half of the screen where they may be edited. 
 

Panel Description 
 

A panel description (up to 14 characters) may be allocated to the panel. 
 

Panel Mode 
 

The only available panel mode is Standard. This may change with future developments. 
 

Panel Type 
 

The Panel Type section indicates the number of zones available in the current panel (2, 4 or 8 
zone). 
 
Quiescent Display Text 
 
You can set up four lines of user-definable text which is shown on the panel when it is in the start up 
condition. Only line 2 and 3 are indicated in a quiescent state. The default text is shown in the 
sample screen above. 
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 Codes 
 
The control panel access codes may be changed as required on this screen. 
 

 
 
The default codes for Access Level 2A (user), Access Level 2B (Supervisor) and Access Level 3 
(engineer) are shown above. They may be changed to any combination of 4 digits. 
 
Upload and download may only be carried out from Access Level 3 (engineer). Changing the 
engineer code from its default will restrict access to the engineer functions to only those who know 
the new code. 
 
A Back Door code can be provided if the codes chosen are lost. If this is required, contact Fike 
technical support with the following information: 

 
1. The control panel serial number 
2. The control panel software version number 
3. The site name and details 
4. Your details 
5. Written authorisation from the legal owner of the system to request back door 
 codes for the system. 

 
 
 
Delays & Timers Tab 
 
The Delays and Timers tab is shown below. 
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Alarm Delays 
 
An alarm delay can be programmed for selected zones with values between 0 and 5 minutes. 
 
An Alarm Confirmation delay may be set up so that when an alarm occurs, it is not immediately 
reported. The system will wait until the end of the delay time and then check that the alarm is still 
present. If it has cleared, the device which was in alarm will be reset and no further action need be 
taken. 
 
The delay time for alarm confirmation can be programmed from 1 – 5 minutes. This option cannot 
be used at the same time as alarm delay. 
 
 
Panel Timers 
 
You can program how often the service timer is to occur so that the end-user is prompted to call for 
a service.  
 
You can also specify a day and a time (hours and minutes on the 24 hour clock) for a weekly test to 
be performed on the panel. Leave the fields blank if you do not want a weekly test or un-tick the 
boxes provided. 
  
 
Day/Night Mode 
 
The Day / Night mode tab is shown below. 
 

 

 
 

Pre-programmed Times (RTC) Enabled 
 
You can set times throughout the week (hours and minutes on the 24 hour clock) for day/night 
mode to be operational by filling in the Days “From To” Table as shown in the tab. There can only 
be one such time range set up per day. 
 
You can also specify (using the zone tick boxes) which zones are to be disabled during the selected 
times. This allows you to disable smoke detection in a zone during the day but not at night. 
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Panel Input Event 
 

With this option, you can configure the system so that day / night mode will follow any panel inputs 
set to day/night mode. 

 
 
Panel Inputs Tab 
 
The Panel Inputs tab is shown below. 
 

 
 
Up to 3 Panel Inputs can be configured on this tab. 
 
A Panel Input can be configured as a Control Event, Remote Fire Event, a Technical Event, a Disablement, 
Day/Night timer input or left un-configured. Some actions can be latching or Non-latching. 
 

 
Control Event 
 
A Panel input can be configured as any of the types of Control Event as shown in the pull-down 
selection list below.  
 

 
 
 
Remote Fire Event 
 
A Panel Input configured as a remote fire can be set to Remote Fire-Full (Latching), Remote Fire-
Full (Non Latching), Remote Fire-No Relay (Latching) or Remote Fire-No Relay (Non Latching). 
These values may be changed using the pull-down selection lists. 
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Technical Event 
 
A Panel Input configured as a Technical Event will sound the sounders. This can be configured to 
be latching or non-latching.  
 

 
Panel Outputs Tab 
 
The Panel Outputs tab is shown below. 
 

 
 
 
 
Non-Monitored Outputs 1 & 2 
 
On the TWINFLEX

®
pro panel there are two relay outputs (1 & 2). The configuration of these two 

outputs is fixed (Output 1 is common fire, Output 2 is common fault), however the description can 
be changed.  
 
A Common Fire Output is activated by any Fire on the system. 
 
A Common Fault Output is activated by any Fault on the system. 
 
 
Monitored Outputs 
 
Two monitored outputs (numbered MO1 and MO2 may be configured so that they will be activated 
when certain conditions occur. Selection is made via radio buttons. Options are, remote sounders, 
remote fire & off (not configured). 
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Printer Tab 
 
The printer tab is shown below. 

 
 

 
 

This feature is for possible future use and is not currently available. 
 

Zone Details Tab 

 

 
 
This screen allows the zones to be turned on or turned off. If for example only 3 out of the 4 zones on a four zone 
panel are used, the unused zone can be turned off to prevent an EOL fault being reported. Any number of zones 
may be turned off and in any order. 
 
Also on this screen are the device type boxes. At present only the CP/DET should be used, the CP/SM/HT position 
should not be used. This will only be available when a new detector is released in the future. 
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Event Log Report  
  
The Event Log Report option allows the creation of text files from any event logs which have previously 
been uploaded from the panel. The files will be in the *.txt format.   
 
This function is also repeated in the form of an on-screen button in the Left hand side toolbar. 

 
 

 
 
A typical report is shown below. 

 

 
 

 
The event log report may be printed utilising the Print Button at the bottom of the screen. 
 
 
 
The event log report may be saved in the format ‘file_name’.txt by utilising the ‘Save As’ command in the 
File menu at the top of the screen. The file may be opened in Microsoft WordPad or imported into Microsoft 
Word. However, some fonts will cause the tabulation to alter when using Microsoft Word. The print function 
may be used directly from the ‘File’ menu, from within Word or WordPad.  
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Connectivity Menu 
 
 

 
 
 

Upload Data from Panel 
 

 Note that before uploading panel data, a site data file (either newly created or an existing file) must have 
been opened on the PC. 

 
Prior to an Upload of the configuration from the control panel to the PC, or a Download of the configuration 
from PC to the control panel, it is necessary for the panel to be in ‘Access Level 3 (Engineer Mode)’. The 
panel must be connected to the PC via a USB lead. 
 
Note that if the panel is left for a period of time, it will log itself out of Access Level 3 (Engineer Mode) so it 
is best to check that it is in Engineer mode before doing anything at the PC. 
 
Upload from control panel can be accessed from the Connectivity drop down menu or the upload button 
which is found to the left of the main screen. 
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Upload Data 
 
The Upload Data button allows you to upload data from the currently connected panel.  A progress bar is 
shown while the data is uploading. If there is a problem, a warning will be given. If this happens, you should 
disconnect the USB and re-connect it before trying again. Also remember that the panel must be in 
Engineer Mode.  
 
Note that you must select a panel in the PC configuration which will be given the uploaded data. When this 
has been selected you can press the Accept Upload button as shown in the example screen below. 

 
 

 
 

 
 

Upload Event Log 

 
It is possible to upload the event log from a panel.  It is necessary for the panel to be in ‘Access Level 3 
(Engineer Mode)’ and the panel must be connected to the PC via a USB lead. 
 
You can save event logs with different dates and times from more than one panel on the PC. 
 
Event logs can be viewed at a later date using the Event Log Report button on the left of the screen (or 
View Event Log Report from the menu bar at the top of the screen) and a hard copy made by pressing the 
Print button when viewing the event log. 
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Download Data to Panel 
 

 
Prior to a Download of configuration data from PC to the control panel, it is necessary for the panel to be in 
‘Access Level 3 (Engineer Mode)’. The panel must be connected to the PC via a USB lead. 
 
Note that if the panel is left for a period of time, it will log itself out of Access Level 3 (Engineer Mode) so it 
is best to check that it is in Engineer mode before doing anything at the PC. 
 
Download to control panel can be accessed from the Connectivity drop down menu or The download button 
which is found to the left of the main screen.  
 

 
 
On pressing it, the following screen is obtained. 
 
 

 
 
 
The Download button on this screen allows you to download configuration data from a selected panel in the 
PC configuration to the panel to which the PC is connected. A progress bar is shown while the data is 
downloading. 

 
If there is a problem, a warning will be given. If this happens, you should disconnect the USB and re-
connect it before trying again. Also remember that the panel must be in Engineer Mode.  
 
It is recommended that you do not use the Cancel Download button once downloading has begun. 
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Diagnostics Tools 
 
This feature is for possible future use and is not currently available. 

 
 
 

‘Help’ Menu 
 
The Help Menu contains a single option which will display the current software version. 

 

 
 
About Page 
 
The About Page obtained from the Help menu gives details of the current software version of the OSP 
program. An example is shown below. 
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Technical Support 
 

For further technical support please contact your distributor.  Do not call the Fike Safety Technology 
technical support department unless your distributor has first given their advice and attempted to rectify the 
issue. 
 
Technical support will not be available if the instruction manual has not been read and understood. Please 
have this instruction manual available whenever you call for technical support. Due to the complexity and 
inherent importance of a life risk type system, training on this equipment is essential, and commissioning 
should only be carried out by competent persons. 
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Your Notes 
 


